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Legal notice 
The information in this manual is furnished for informational use only. No part of this manual may be reproduced or transmitted in any form or by any 

means, electronic or mechanical, for any purpose, without the prior written permission of PlayBox Technology UK Ltd. 

 

The software, described in this manual, is owned by PlayBox Technology UK Ltd. It is protected by Copyright Law of England and Wales, as well as by 

international copyright treaties, and may be used or copied only in accordance with the license agreement. 

 

PlayBox Technology UK Ltd provides this manual “as is” without any warranty, either express, or implied. 

 

This publication may contain typographical errors or technical inaccuracies. While every precaution has been taken in the preparation of this document, 

PlayBox Technology UK Ltd assumes no responsibility for errors or omissions. Nor is any liability assumed for damages, resulting from the use of the 

information, contained herein. Changes are periodically made to the information herein. They will be incorporated in new versions of the manual. Please, 

check the PlayBox Technology UK Ltd website regularly for User Manual updates. 

 

PlayBox Technology UK Ltd may introduce changes or improvements in the products, described in this manual at any time, without any special notice. 

Please, address your comments or questions to: 

PlayBox Technology UK Ltd 

Brookmans Park Teleport 

Great North Road 

Hatfield AL9 6NE 

United Kingdom 

support@playboxtechnology.com 
 

www.playboxtechnology.com 

https://playboxtechnology.com/
mailto:support@playboxtechnology.com
https://playboxtechnology.com/
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Preface 
 

Dear PlayBox customer, 
 

Thank you for purchasing our product! We would like to assure you that you have chosen the most cost-effective and versatile TV 

automation system on the market. As always, we are trying to stay close to our customers’ needs, making sure they all receive adequate 

support and satisfaction. Your opinion about our product is an exceptionally valuable source of information for us. The ease of working 

with the PlayBox products results mainly from the suggestions and comments of our current respected customers. 

 

This manual is structured into several sequential chapters, each aiming to ease the installation, fine tuning, and use of our products. We 

hope that you will enjoy working with it, and we are anxiously looking forward to receiving your feedback. 

 

Please, send your questions, suggestions, and assistance requests to: 

support@playboxtechnology.com 

General feedback: 

 

info@playboxtechnology.com 

mailto:support@playbox
mailto:info@playboxtechnology.com
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Style Conventions 
• File names, software, documents or terms are written in italics 

▪ The data is written in the settings.ini file. 

▪ The file is located in C:\Program Files\DMT\AirBox 

▪ For further information read Shortcuts reference book. 

▪ The VTR is controlled via RS-422. 

• Direct quotations from the computer screen are presented as follows: 

▪ Menu Items and commands 

▪ Tab/Page names 

▪ Column names (i.e. in a playlist or another grid) 
▪ Field names, check boxes 

▪ Buttons 
▪ Screen readings are written in [square brackets] 

▪ The keyboard keys are enclosed in <> signs 

▪ Terms are defined in the Glossary at the end of the manual 

• The arrows, used in the setting procedures mean as follows: 

▪ ➔ A menu item follows; 

▪  A page(tab) name follows; 

▪ → A field name, a check box name, or a value name follows. 

 

Except for arrows, you can distinguish between the relevant menu categories also by the styles, listed above. 
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GETTING STARTED 

Quick Start 

1. Launch TimeShiftBox. 

2. On the File menu click Preferences. 

 

 
 

 

 

3. In the dialog box, select your DeltaCast board from the Video Input and Video Output lists– for input and output, respectively. 

4. In the Video Settings area select the Video Standard and the Genlock Source. 

5. In the General area enter the shift time values (the delay interval) in the Shift Days and Shift Time fields. 

6. Click the Apply button. 

7. In Timeshiftbox, below the Output preview window click the  Start button to start time shifting, and then click the Stop button to 

stop it. 
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USER INTERFACE 

TimeShiftBox is a solution providing accurate program time delays. Depending on the available storage, the delay could be even longer than a week. 

TimeShiftBox allows capturing of the source video and playback of the captured file. TimeShiftBox captures the source video in a temporary file. After 

the user defines a time period (i.e. after shifted start time), the playback of the temporary file will start. All temporary files, older than 16 hours, are 

deleted automatically from the system. 

The major modules of the TimeShiftBox user interface are the Input and the Output preview windows. The Input preview displays the original video signal 

and the Output preview – the shifted (delayed) video. 

 

Menu Bar 

 

Logo Configuration 

 

 

 
 

Output Preview 

 

 

 

 

 

 

 

 

Stop Button 

 

 

 

 

 

 

 
Input Preview Available space for capturing 

 
 

Under the preview windows there are four timers: 

 

Current Time – the current system time; 

 

Capture Start Time – the start time of TimeShiftBox; 

 

Shift Time – the time delay set by the user. The shifted start time, as shown above, is 1 hour and 2 milliseconds; 

 

Playback Start Time – the start time of the delayed (shifted) playback. It is the sum of the Capture Start Time and the Shift Time. 
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Below the timers in the Output preview section, there are the Start and Stop buttons. Click the Start button to start time shifting and Stop button to 

stop it. 

 

TimeShiftBox captures the incoming video signal in a temporary file and then plays it out with the delay set by the user. The available free disk space for 

capturing is visible in the Disk Free space section. 

 

MENU BAR 

On the File menu there are two available settings: Preferences and Logo Config. 

 

Preferences 
 

 
 

In the Video Input/Output area select your DeltaCast board from the corresponding drop-down lists – for input and output, respectively. All available 

DeltaCast boards on the workstation, where TimeShiftBox is installed, should be visible in the Video Input and Video Output lists. 

 

Use the Video Settings preferences to select the Video Standard and the Genlock Source. Use the Horizontal and the Vertical Offset spin-boxes to set shifting 

of the Horizontal and Vertical Ancillary lines (HANC and VANC lines), respectively. 

 

In the General area you can configure the shift time. Enter the desired shift time via the Shift Days and Shift Time fields. Select a path in the Temporary 

Folder field, where the temporary captured file will be saved. 

 

 
 

In the Startup area you can enable the Launch TimeShiftBox when Windows starts up option and set a time delay in the in the Start TimeShiftBox after … sec 

spin-box. As shown in the example above, TimeShiftBox will be initiated 10 seconds after Windows has started. 

 

IMPORTANT: If you are using more than one instance of TimeShiftBox, make sure to set different temporary folders for each instance. 

 

NOTE: The time format of all timers is: HH:MM:SS:MS. 

 

EXAMPLE: If the Capture Start Time is 14:40:00:00, and the Shift Time is set to 00:01:00:00, the Playback Start Time will be 14:41:00:00. 
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The VBI lines to capture preferences allow you to select which VBI lines to be captured in the temporary file, used for setting the time delay. 

 

Logo config 
 

 

In the Logo configuration dialog you can set logo images to be displayed in TimeShiftBox. You can also access this dialog by clicking the Show 

Logo/Hide Logo button in the upper right corner of the main interface. 

 

To load a new logo, click the Load button, and select a file. It will appear in the Preview area. Click the OK button to save the logo file in the preset list. 

 

 
 

The Invert alpha button inverts the alpha key of the logo (if the original picture file has an alpha). 

 

The Matte Color section allows you to set a background color, which will mix with the transparent colors of the image and will make them easy removable. 

The Position area displays the logo position on the screen. You can select and move the logo in the position box with the mouse. 

Select the Show on output check box if you want to display the logo while you are editing it. 

Use the Fade Duration spin box to set in how many frames the logo will disappear. 

 

 
 

Click the Reset Position button to reset the logo position to its initial state. 

 

NOTE: All changes will be shown on the screen immediately. 

 

NOTE: The logo file format depends on the decoder. 32-bit RGBA files are most preferable, but TGA, JPG and PSD files are supported, as well. 
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On the Help menu click About to get information for the current version of your TimeShiftBox, its expiration date and your WIBU Box number. 

 

PlayBox Doctor Report 
 

On the Help menu click PlayBox Doctor. 
 

 
 

PlayBox Doctor allows you to generate problem reports. It is integrated in each PlayBox module. It gathers information, needed for the PlayBox support 

team, in order to provide you with prompt solutions. 

 

The fields you need to fill in are self-explanatory. Some of the information is collected automatically at startup. 

 

You need to type your name, email, company, and select your country from the list. Choose the hardware platform you are using for TimeShiftBox and 

specify the installed driver version. When you fill in all the needed information in the General area, click the Apply button to insert this information in the 

report. 

 

In the Diagnostics section you can select a problem that you are having, from the corresponding list, or you can describe it manually in the Additional 

information field. Click the Add button to insert the description of the problem in the report. 

 

Click the Thorough Scan button to scan the entire system. PlayBox Doctor will generate a list of all files stored on your hard disk drive. Include this 

information in your PlayBox Doctor report if you suspect that some files might be disturbing the smooth running of TimeShiftBox. 

 

Click the PlayBox Files Scan button, in order to search for missing or problematic PlayBox files and to add this information to your PlayBox Doctor 

report. 

 

The Get Filter button adds information about the filters used in TimeShiftBox to your report. 
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If you want to make screenshots, click the Screenshot button. After PlayBox Doctor minimizes automatically, select the area you want to shoot. 

 

If you are having issues with a specific file, click the Analyze button to browse for it. The support team will receive information about the file’s structure. 

 

Attach any files you want to send by clicking the Attach button. If your attachments are bigger than 4 MB, please upload your files on the PlayBox FTP. 

Please contact us at support@playboxtechnology.com to get an uploader name and password. 
 

Clicking the Get Log button attaches automatically the log files of TimeshiftBox. 

 

The Get DBase button is active only if you have selected DataBox from the PlayBox module list. This action provides information about the database in 

your DataBox. 

 

 

 

NOTE: Do not forget to add your contact information and send us the generated PlayBox Doctor report directly (if Internet connection is available) or 

save it as a file and send it later. 

mailto:support@playboxtechnology.com
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